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Cybertracker Hinweise zur Handhabung 

 
Für einen Nutzer des Cybertrackers liegt die Einstiegsschwelle zugegebenermaßen recht hoch. Wer nicht täglich 

gewöhnt ist, mit Computern umzugehen und wem es nicht ganz leicht fällt, sich durch englischsprachliche Handbücher 
zu wühlen, ist schnell genervt von der Fülle der Informationen. 

Aus diesem Grund habe ich einmal versucht, die wesentlichsten Dinge zusammenzufassen, in der Hoffnung, das dieses 
Papier hilfreich ist für die ersten Schritte. 

Ich bin dankbar für jede konstruktive Kritik und Anregung, um das Dokument zu verbessern.  
Also: kommuniziert bitte, wenn ihr nicht klar kommt! 

 
Holger Röhle, Burkhardtsdorfer Str. 20, 09235 Burkhardtsdorf 

Tel.: 037209-2029/ Email: info@dachspfad.de/ 
Internetadresse mit weiteren Infos zum Cybertracker: 

http://www.dachspfad.de/html/cybertracker.html 
 
 

1. ÜBERBLICK ÜBER DIE KOMPONENTEN............................................................................................ 2 

2. BEGRIFFE..................................................................................................................................................... 2 

3. INSTALLATION .......................................................................................................................................... 2 

4. EIN NEUES PROJEKT IN EINER NEUEN DATENBASIS IM CYBE RTRACKER ANLEGEN...... 3  

5. EIN PROJEKT IM CYBERTRACKER ÖFFNEN................. ................................................................... 3 

6. DAS PROJEKT FÜR DIE DATENERFASSUNG PER HANDHELD INSTALLIEREN ..................... 3 

7. DAS PROJEKT AUF DAS HANDHELD BRINGEN (HOTSYNC) ..... ...................................................4 

8. DATEN SAMMELN ..................................................................................................................................... 4 

9. GESAMMELTE DATEN MIT CYBERTRACKER-PC SYNCHRONSIEREN .................................... 4 

10. GESAMMELTE DATEN ANZEIGEN................................................................................................... 4 

11. NEUE KARTE HINZUFÜGEN............................................................................................................... 5 

12. NEUE ABFRAGE (DATENFILTER = QUERY) ERSTELLEN....... ...................................................5 

13. NEUE TABELLE HINZUFÜGEN .......................................................................................................... 6 

14. HINWEISE ZUR DATENABLAGE UND DATENSICHERUNG......... .............................................. 6 

15. WO FINDE ICH HANDBÜCHER UND ANDERE INFORMATIONEN. ... ....................................... 7 

16. ERSTELLUNG EIGENER SEQUENZEN............................................................................................. 7 



 Handhabung Wildniswissen 

Holger Röhle  (15.01.2005) Seite 2 von 7 Seiten ct_handhabung.doc 

1. Überblick über die Komponenten 

Konkrete Sequenz, 
z.B. „Master Shikari“Konkrete Sequenz, 

z.B. „Master Shikari“Konkrete Sequenz, 
z.B. „Master Shikari“

PC-
Cybertracker-

Software

* Verwaltung der Projekte aus 
Sequenzen, Maps und Tabellen
* (automatisches) Upload und 

Download zum Handheld
* Anzeige, Auswertung und

Export der gesammelten Daten
* Erstellung neuer Projekte

Die Daten sind komfortabel in Karte und Tabellen darstellbar.

Eine Abfragesequenz zur Eingabe konkreter Daten im Handheld
ist auf den jeweiligen Einsatzfall hin zugeschnitten.

Die aktuelle Sequenz wird 
in das Handheld geladen.

Die gesammelten Daten werden 
zurück in den Computer gespeichert.

Magellan GPS Companion
zum Bestimmen der 
Koordinaten der Messpunkte
und zum Aufzeichnen des 
Weges im Gelände

Handheld (hier Handspring Visor):
Pocket PC zur Eingabe der Daten
im Gelände

Nützliches Zubehör:
Backup-Modul zur 
Datensicherung

USB-
Schnittstelle

und HotSync-
DockingStation

.

 

2. Begriffe 
Sequenz auf eine bestimmte Gruppe gleichartiger Anwendungen zugeschnittenen Abfrage- und 

Eingabereihenfolge von Daten -> Diese Sequenz ist letztendlich auf dem Handheld als 
Abfolge von Menübildern und Eingabemöglichkeiten sichtbar.  
Beispiele: „MasterShikari“ = Sequenz zur Dateneigabe insbesondere für Tiere Nordamerikas 
(Quelle: Jon Young) / „Wildlife“ = Sequenz zur Dateneingabe für Tiere Afrikas (Quelle: Louis 
Liebenberg)  

Database „Verwaltungselement“ in der Cybertrackersoftware auf PC: enthält ein oder mehrere Projecte, 
die alle auf ein und derselben Sequenz aufbauen 

Project „Verwaltungselement“ in der Cybertrackersoftware auf PC: basierend auf einer Database sind 
im konkreten Project z.B. alle Karten (Maps) und Tabellen für ein bestimmtes Projekt abgelegt 
Beispiel: In der Database„Wildlife“existirt das Procet „Antelope“ = Dateneingabe füreine 
Untermenge aller Tiere nämlich der Antilopenarten im Nationalpark (Quelle: Louis 
Liebenberg) 

Hotsync Automatismus der PC-Software zum Pocket-PC (auch als „Palm Desktop“ bezeichnet), der 
gewährleistet, dass die Daten übertragen werden, sobald der Pocket-PC auf der 
DockingStation aufgesteckt wird. 

Query Abfrage oder Filter, wodurch aus den gesammelten Daten eine bestimmte Untermenge zur 
Anzeige und Auswertung ausgewählt wird 

 

3. Installation 
A) Palm-Deskop: Handspring- oder Palm-CD einlegen, wenn nicht automatisch aufgerufen wird - über setup.exe die 

Installation aufrufen 
  

B) Cybertracker:  Cybertracker-CD einlegen, wenn nicht automatisch aufgerufen wird - über setup.exe die 
Installation aufrufen [Installationsverzeichnis ist normalerweise c:\programme\cybertracker und sollte so belassen 
werden] 
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4. Ein neues Projekt in einer neuen Datenbasis im C ybertracker anlegen 
normalerweise sind im Auslieferungszustand von Luis Liebenberg die Projekte/ Databases „Wildlife“, „AppleFarm“ 
und „MarketSurvey“ vorhanden. Da wir in der Regel nicht mit diesen Projekten arbeiten wollen, müssen wir eine neue 
Datenbasis für unsere Projekte öffnen.  
 
Das Anlegen einer neue Datenbasis geht folgendermaßen: 
1. File -> DatabaseManager => Fenster „DatabaseManager“ öffnet sich  
2. auf eine freie Stelle klicken -> rechte Maustaste -> New -> Blank => ein Icon mit dem Namen „New Database1“ 

wird erzeugt 
3. NewDatabase1 umbenennen in den gewünschten Namen => Fenster „Confirm“ öffnet sich -> Meldung mit „Yes“ 

bestätigen 
4. Die neue Datenbasis anwählen -> rechte Maustaste -> Import => Fenster „Import database“ öffnet sich 
5. gewünschte Datenbasis suchen (Das ist immer ein File mit der Endung CTZ, z.B. MasterShikari.CTZ und stellt die 

sogenannte Sequenz dar.) 
6. mit „Öffnen“ bestätigen => Fenster „Confirm“ öffnet sich -> „Yes“ drücken => nach erfolgreichem Import öffnet 

sich ein neues Fenster „Import log“ -> Meldung mit „OK“ bestätigen 
7. DatabaseManager schließen 
 
(Hinweis: nicht benötigte Datenbasen können im DatabaseManager oder einfach unter c:/cybertracker/database/ 
gelöscht werden) 
 

5. Ein Projekt im Cybertracker öffnen 
1. File -> Open => Fenster „Open Project“ öffnet sich  
2. Database auswählen => im Fenster werden alle zur Database gehörenden 

Unterprojekte angezeigt 
3. Unterproject auswählen  
4. ok. 
 
 
Tipp: Sollte das Fenster mit dem REGISTRIERUNGs-Dialog geöffnet 
werden -> der  register-key  ist greenware 
 
 
 

6. Das Projekt für die Datenerfassung per Handheld installieren 
Das Projekt, was auf dem PC nun läuft, muss jetzt noch aufbereitet werden, damit es auch auf dem Handheld 
funktioniert. Dieser Vorgang wird im Cybertracker „installieren“ genannt. Tools -> Synchronize -> Install -> ... 

 
Palm-Deskop: (einmaliger Vorgang, danach merkt sich das Programm diese Einstellung) 
 Palm-Desktop einstellen: Installiere -> Hinzufügen -> ... Folgende Dateien sind aus dem Verzeichnis 
c:\programme\cybertracker auszuwählen: cybertracker.prc, icons.pdp, items.pdp, screens.pdp  (Normalerweise – wenn 
die Installationsreihenfolge aus Punkt �3 eingehalten wird - sind diese Einträge bereits zu sehen!) 
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7. Das Projekt auf das Handheld bringen (Hotsync) 
Tipp: Falls das der erste Hotsync-Vorgang ist, empfiehlt es sich die Handspring-CD bereitzuhalten, da normalerweise 
der Treiber noch zu installieren ist. Erscheint ein Installationsfenster, ist die CD einzulegen. Der Treiber wird 
üblicherweise selbst gesucht und installiert. 
 

1. Dockingstation in USB-Schnittstelle des Computers einstecken 
2. Ggf. Treiber installieren (siehe Hinweis) 
3. Handheld auf Dockingstation aufstecken 
4. Hotsync-Taste (vorn in der Mitte der Dockingstation) drücken 

8. Daten sammeln 
Wichtiger Hinweis Nummer 1!!! Um zu vermeiden, dass sich der Pocket-PC „aufhängt“ und nicht mehr bedienbar 
sein sollte, ist  

(A) das GPS-Modul erst im Freien aufzustecken                                                                             und  
(B) die Aktivierung der GPS-Messung im Cybertracker ebenfalls erst im Freien vorzunehmen    und 
(C) bevor ich wieder ins Haus gehe, ist GPS auszuschalten 
 

GPS on/ off: wird in allen Sequenzen ziemlich am Anfang eingestellt. 
 
Tipp: Die einstellbare Intervallzeit dient zur automatischen Aufnahme von Koordinaten. Bewegt ihr euch langsam, 
solltet ihr eine kleinere Intervallzeit einstellen. Bei der Darstellung auf einer Karte werden diese Messpunkte dann mit 
gezeigt und ihr seht euren Weg im Gelände. (Darüberhinaus wird am Ende der Dateneingabe einer Messung (ok oder 
Stop) die dazugehörige Koordinate ebenfalls und nochmals abgelegt.) 
 
Tipp: Sollte es doch mal vorkommen, dass im Haus nach dem Einschalten des Gerätes der Cybertracker mit der 
Anzeige de GPS-Datenfensters hängen bleibt, hilft meistens: nochmals vor die Tür gehen, einen Messwert aufnehmen 
lassen und dann sofort das GPS deaktivieren. 
 

Wichtiger Hinweis Nummer 2!!! Das Gerät immer vor dem Zuschalten Aklimatisieren  lassen, insbesondere beim 
Übergang von kalt nach warm wegen dem Schwitzwasser -> Mir ist es schon passiert, dass ein sofortiges 
Wiederzuschalten des Gerätes nach dem ins-Haus-kommen alle Daten gelöscht hat. � 
 
Das eigentliche Sammeln der Daten kann und möchte ich hier nicht beschreiben, da es abhängig ist von der konkreten 
Sequenz und natürlich der aktuellen Aufgabe. (siehe hier z.B. Kapitel �15) 
 

Trotzdem dazu der Hinweis Nummer 3!!! Bei der Eingabe von Messwerten wird eine ganze Zahl in den 
Datensätzen anders abgelegt als eine Kommazahl. Es macht Sinn, sich darauf zu einigen immer GANZE ZAHLEN 
einzugeben. D.h. bei kleinen Längen, wie z.B. Fußabdrücken die Basis Millimeter (würde sogar noch bei Elefant 
passen!) und bei Schrittlängen usw. eher die Einheit Zentimeter zu wählen. (Ausnahme: Insekten und  Mäuse) 
 

9. Gesammelte Daten mit Cybertracker-PC synchronsie ren 
1. Handheld auf Basisstation aufstecken 
2. Hotsync-Taste (vorn in der Mitte der Basisstation) drücken 

10. Gesammelte Daten anzeigen 
Zu einem Project gehört neben der konkreten Sequenz eine aufgabenabhängige Auswertung. (Wenn ich z.B. ein 
Monitoring über Wölfe machen möchte, interessieren mich vielleicht gerade nicht die Vögel, die ich auch mit 
beobachtet habe. Aber vielleicht sind ja die Wetterdaten, die ich ebenfalls mit aufgezeichnet habe, von Interesse. Und 
möglicherweise interessieren mich von den Daten über die Wölfe nur die Informationen der letzten Woche…) 
Diese Auswertung stellt also einen Filter dar, den ich über alle gesammelten Daten lege. Diesen Filter kann ich mir 
selbst erstellen (siehe Kapitel �12) oder die bereits vorhandenen nutzen. Im Queryfenster werden alle zum Project 
gehörenden Querys angezeigt. Ein Haken im Kästchen aktiviert sie. Die so ausgewählten Daten sind auch auf Karten 
(Maps) und in Tabellen darstellbar. Wähle dazu: Menü „View“ -> Maps oder Table und wähle diejenigen aus, die du 
benötigst. Eine Anzeige der einzelnen Messdaten bekomme ich durch Drücken der Taste „Inspect selection“ (das ist 
das Kästchen mit dem kleinen „i“) 
 
Tipp: Der Filter (die Query) wirkt sich auf alle Anzeigen und auch auf den Datenexport (Menü „File“ -> Export) aus. 
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11. Neue Karte hinzufügen 
1. Kartenausschnitt auswählen (z.B. in einem Viewer eines Digitalkartenprogramms wie Top50) 
2. Kartenausschnitt als BMP-File ablegen (vorzugsweise unter c:\programme\cybertracker\map) 
3. Koordinaten der linken oberen und rechten unteren Ecken bestimmen (Angaben in Dezimalgrad; Formatbeispiel : 

14,40666; weitere Hinweise siehe unten) 
4. Cybertracker-Programm am PC aufrufen 
5. Im Cybertracker das Projekt öffnen (File -> Open -> Database -> Projektname) 
6. Den Mapviewer öffen (View Map) => neues Fenster öffnet sich und zeigt die 

Maps, die bereits angelegt sind 
 
 
 
 
 
 
 
 
 

7. Im Fenster eine neue Map anlegen (rechte Maustaste -> New / 
Name vergeben) 

8. Map-Eigenschaften bearbeiten (neue Map anwählen, rechte 
Maustaste -> Properties) => Edit Map Template öffnet sich 

9. Lasche „Image“ anwählen und bei „File“ die BMP-Datei (siehe 
Punkt2) anwählen (auf die „...“  drücken und im Dateibaum 
suchen) 

10. Lasche „Position“ anwählen und die Koordinaten (siehe Punkt3) 
eingeben 

11. Koordinaten speichern mit „Save Image  Coordinates“ 
12. Ok 
13. Ok => neue Karte wird angezeigt 
 
Tipp: zum Umrechnen von Koordinatensystemen: 
Cybertracker unterstützt nur das Format „Dezimalgrad“. Es gibt eine 
Reihe anderer Koordinatensysteme, die alle ineinander umrechenbar 
sind, zum Beispiel: 14°26'25" = 14 + (26/60) + (25/3600) = 14,44028 
 
Tipp: damit man die Maps und deren Koordinaten immer wieder 
findet, bietet es sich an, eine Liste mit den Bildnamen und den zugehörenden Koordinaten auf dem Rechner 
mitzuführen (und beim Datensichern auch mit zu sichern). 
 
Tipp: immer schön Speichern zwischendurch! (Menü „File“ -> Save) 
 
 

12. Neue Abfrage (Datenfilter = Query) erstellen 
1. „Query“-Fenster -> rechte Maustaste -> „New“ -> „New 

Query“ wird angelegt  
2. „New Query“ einen eigenen Namen geben 
3. anklicken -> rechte Maustaste -> „Properties“ 
4. Fenster „“Query: New Query“ öffnet sich 
5. In „Range“ und „from .. To“ den gewünschten Filterzeitraum 

einstellen 
6. aus den Daten die gewünschte Auswahl treffen  
 
Tipp: die Daten werden über logische Verknüpfungen 
zusammengestellt (AND; OR; NOT …). Wer das nicht versteht, 
bitte die Manuals lesen (Mein Beispiel funktioniert nicht! Es gibt 
kein Tier, welches gleichzeitig Cape Fox und Cape Hare ist!!) 
 
Tipp: immer schön Speichern zwischendurch! („File“ -> Save) 
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13. Neue Tabelle hinzufügen  
1. Menü „View“-> Table öffnet das Fenster „Table View“ 
2. rechte Maustaste -> „New“ -> „New Table“ wird angelegt  
3. „New Table“ einen eigenen Namen geben 

 
 
 
 
 
 
 
 
 

4. anklicken -> rechte Maustaste -> „Properties“ 
5. in der Lasche „Columns“ in das linke frei Fenster mit der 

rechten Maustaste klicken -> „New“ ->“ New Column“ 
entsteht 

6. auf der rechten Seite die Eigenschaften der Spalte 
ändern: * „New Column“ einen eigenen Namen geben  
(Das wird die Überschrift der Spalte.) 
* „ Match Type“ kann „Category“, „Group“ oder „Item 
sein (Beispiel: Category = ClassificationData oder 
Group = Mammals oder Item = Wolf, d.h. also Category 
sammelt alle Klassifizierungen der Tiere, Group 
sammelt alle Säugetiere und Item nur die Wölfe aus den 
Daten heraus und schreibt sie in die Tabelle) 
* „ Cell Value“ sollte auf „Alias“ stehe, denn dann 
kommen Texte, ansonsten die intern benutzten 
Kodierungen, die wenig aussagekräftig sind 
* alles andere ist erst einmal nicht so von Bedeutung 
aber auch hier gilt: 

7. Wer mehr wissen will, bitte die Manuals lesen / bzw. ein bisschen spielen und probieren 
 
Tipp: immer schön Speichern zwischendurch! (Menü „File“ -> Save) 
 
 

14. Hinweise zur Datenablage und Datensicherung 
Die Installation der Software erfolgt normalerweise in c:\programme\cybertracker. Leider beherrscht das Programm 
selbst nicht so ohne Weiteres eine Ablage von Daten außerhalb dieses Installationsverzeichnis. Gesammelte Daten eines 
Projektes liegen dann in c:\programme\cybertracker\database\“databasename“\backup\data.“nummer“.ctz  
(Beispiel: c:\programme\cybertracker\database\mastershikari\backup\data.10.ctz ist das zehnte Stück der gesamten 
Datenbank aller Projekte der Datenbasis „Mastershikari“. Die Nummer wird automatisch beim Dateneinsammeln 
vergeben.) 
 
Tipp: Alle zusätzlichen Daten, wie z.B. eigene Maps sollten ebenfalls unter c:\programme\cybertracker mit abgelegt 
werden; z.B. c:\programme\cybertracker\map. 
 
Tipp: Es bietet sich an, die Projekte (da dort die Querys, die Tabellen und Einstellungen für die Maps mit abgelegt 
sind) und diese Datensammlungen von Zeit zu Zeit auf CD oder anderweitig zu sichern! Also am besten das gesamte 
Verzeichnis von c:\pogramme\cybertracker sichern! 
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15. Wo finde ich Handbücher und andere Informatione n. 
Louis Liebenbergs Seite mit 
Informationen allgemeiner Natur, zu 
Projekten, Tipps zum Download und 
zur Hardware, Diskussionsgruppen 
und vieles mehr … 

http://www.cybertrackerworld.com/index.html 
 

Cybertracker – online – help http://www.cybertrackerworld.com/Help/Index.htm 
 

MasterShikari guide http://www.wildernessawareness.org/cybertracker/index.shtml 
 

MasterShikari - Getting started http://www.wildernessawareness.org/cybertracker/files/Getting%20Start
ed.pdf 
 

MasterShikari - Manual http://www.wildernessawareness.org/cybertracker/files/Master%20Shika
ri%20Sequence%20Manual.PDF 
 

Cybertracker-Software: aktuelle 
Downloadseite (kann sich aber mal 
ändern!) 

http://www.palmgear.com/index.cfm?fuseaction=software.showsoftware
&prodid=11157 
 

 
Demnächst auch eine ständig aktualisierte Sammlung unter http://www.dachspfad.de/html/cybertracker.html 
 

16. Erstellung eigener Sequenzen 
 
Das ist eine nicht ganz so einfache Angelegenheit. Deshalb übersteigt dies auch die Möglichkeiten, die dieses Papier 
bietet. Ich verweise deshalb auf Kapitel �15. Im Cybertracker-Manual werden alle Schritte detailliert  beschrieben. Hier 
nur folgende Grafik, die ich im Netz gefunden habe, um wenigsten einige Begriffe, die ab und zu auch während der 
Bedienung auftauchen, zu erläutern: 

 


